
 

PMATechnologies.com 

QUICKSTART GUIDES &  
SUPPORTING RESOURCES 

 

 

 

  

 

 

 

 

 

 

TABLE OF CONTENTS 

1. Quickstart Guide 

a. Basics: Directly Analyze a P6 xer With Schedule MD 
b. Basics To Use Schedule MD in NetPoint 

2. Schedule MD Details 

a. Tables of MD Definitions & Thresholds 
b. List & MD Tab Location of All Data Metrics  

& DCMA Metrics With Definitions 
c. The MD Inputs: The Narrative Checklists 
d. What Is Scored For Each Type of Schedule? 

 



 

QUICKSTART GUIDE 
Directly Analyze A P6 XER With Schedule MD 

QUICKSTART GUIDES &  
SUPPORTING RESOURCES 

 



DIRECTLY ANALYZE A P6 .XER WITH SCHEDULE  

 

 

 

Schedule MD applies 33 reliability metrics and tallies100’s of data metrics for direct analysis of an .xer. This is 
particularly helpful for large schedules, and preserves the original CPM attributes. The most basic steps follows: 
1. Prep the P6 project before .xer export. Schedule and summarize the project, and export .xer.  

2. Launch MD & Schedule MD Inputs. Open an .xer via the MD desktop shortcut. Then complete the Properties and 
Review & Sign tabs.  

3. Exclude unmeasured metrics. Uncheck metrics that do not apply to the .xer analysis.  

4. View results, run reports & custom lists. View results in the Metrics Manager (MM) via a widget, matching object list, or 
run MD reports and or custom metric list. 

1. Prep the P6 Project Before Analysis in  
In P6 before opening the .xer in MD, open the project in P6 and complete the following 3 steps from the P6 Tools menu.  

1. Schedule the project. Via Tools > Schedule, click the Schedule button. 

2. Summarize the project. In Primavera via Tools > Summarize > Open Projects from the menu bar. Click OK. 

3. Export an .xer. With the project open, Click File > Export from the menu.  With Primavera PM / MM – (.XER) selected, 
click Next. With Project selected, click Next. Check the project(s), click Next. Name the file and click Finish. 

2. Launch           & Enter Schedule Inputs  
Launch MD and select an .xer file and project. Then at minimum for each MD analysis, the 
Properties and Review & Sign tabs should be completed in Schedule MD Inputs.  

1. Launch MD from the desktop icon. Navigate to the .xer. When MD opens a 
project the first time, Schedule Inputs is the first window that opens. If there is 
more than project in the .xer, select a project from the List of available projects. 

2. Enter Schedule MD Inputs. At minimum, the Properties & Review & Sign tabs 
must be completed as they set the metrics applied and thresholds. Further, the 
Signoffs and Narrative are the primary sources of every Comprehensive score.  

3. Save Inputs. Click Save to save the MD Inputs to the .xer. See the MD Inputs at any time via the MM list icon.  

Complete the Properties tab 

1. Select Revision, Level, and Delivery from menus. 

4. Set criticality thresholds as critical and near-critical 
counts factor into several metrics.  

2. Completion Likelihood is not required (if not risked, 
risk metrics may be excluded).  

3. Next click the Review & Sign tab to complete the 
tab. Or, click Save to close the Inputs window and 
MD prompts saving the .xer with inputs.  

Complete Review & Sign tab. Narrative Checklist 
1. Check the Narrative checkbox. 

2. In the bottom window Primary Checks tab, check 
Yes or No for each question.  

3. Complete all tabs until all questions show as 
Answered at the bottom of the checklist window.  

 

Finish Review & Sign. Add Revision, Stakeholders, & Sign-offs  
1. Click Add Revision. Type a name a click Enter. 
2. Click Add Stakeholder. Enter a name and click Enter.  

3. Click Undefined below Role and select role from the menu.  

4. Click the Signoff check box. The comment window opens for an 
optional comment. Click Continue.  

5. Click Sign in Confirm Signature. Once signed, a stakeholder 
cannot be edited.  

6. Repeat steps 2-5 for new stakeholders and signoffs. To review the 
number of signoffs needed, in MM go to Comprehensive tab > 
Aligned > Signoffs to see the threshold (generally 4-5).  

7. When finished, click Save. MD prompts save of the .xer with inputs, 
and MM opens.  

NOTE: Any plan change, whether calculated or only a graphic change, 
will archive signoffs and a new Revision, Stakeholders, and Signoffs are 
required to restore the score.  



 

NOTE: This guidance covers only the absolute minimum steps necessary to run an MD analysis on an .xer using the desktop MD application. For example, there are 
additional steps in the MD Inputs available to include a base case, weather metrics using planned NOAA weather data, and completion likelihood, but they are 
optional and can be easily added to an analysis. For more details on all these steps, please see the NetPoint User Guide found in In the NetPoint Help Menu. 

3. Exclude Unmeasured Metrics 
The first time the MM opens for a project, the score is artificially low since all metrics are 
scored even if they cannot be calculated. Hence, all uncalculated metrics should excluded 
as follows, in particular exclude all 9 metrics that cannot be scored for an .xer.  

1. Identify Unmeasured Metrics. Look for asterisks which indicate the presence of an 
unmeasured metric in a tab. Go to each tab and expand nodes to see * at excludable 
metrics displaying with NA and an active check.  

2. Exclude metrics: In each tab, expand nodes to uncheck active checks and the red X 
changes to a gray NA icon (NA and header node check remains even if all component 
metrics are unchecked/excluded). Faded checks cannot be excluded.  

TIP: A metric is only eligible for exclusion if it does not apply (weather, risk, based on MD Inputs 
Schedule Properties) or if it cannot be calculated due to a lack of a denominator based on the metric 
definition. See definitions by hovering cursor over a metric label in the MM, click the View icon      , or 
see complete list in the MD Cheat Sheets. 

4. View & Report MD Results  
In each tab, metrics are divided into MD, DCMA, 
and data metric sections in the MM top window. 
Expand nodes and scroll the list to click to select 
a metric and see the result in the lower results 
window as a visual widget, or go to the 
customizable matching object list, or run 
standard MD reports.  

1. Dashboard widget. Default MM display to visualize selected metric result.  

2. Matching object list. Select a metric in an expanded node in the MM top window, then select Matching objects from the 
Viewing menu to see customizable list.  

3. Filters: Use the filter box above the window to filter the list below. Clear filter to refresh to see complete MM results.  

 

TIP: More on results. Take time to explore the 100’s of data metrics listed in in each tab as they provide a great deal of information on the 
project. For example, you can see the % of links with lags, find the % of critical, near critical, or activities with negative total float, etc., to give 
very useful neutral data on the of the project schedule.  

9 Metrics that cannot apply 
to .xers (only NetPoint): 
1. Breaching Finish Dates,  
2. Breaching Start Dates,  
3. Off-base Delays,  
4. Improper Detail,  
5. Subjective Duration 
6. Missing Resources  
7. Abnormal Resource Logic 
8. Secondary Calendar  
9. Benchmark Frequency 

 

 

MD reports offered via the MM List Icon.  
1. Summary Report. Includes all metrics, scores, and definitions, 

but not the matching object lists. Ideal for executive reports.  
2. IQ Report. Includes MD metrics, scores, definitions, and 

matching object list. Ideal to drill down into results.   
3. DCMA Report. Includes only the DCMA 14-point metrics and 

matching object lists (only report with lags and leads).  
4. Deficiency Report. Includes all activities organized into a 

tornado diagram based on number of metrics outside of the 
threshold with the corresponding matching object lists. Does 
not include MD scores or definitions. Ideal to review activity 
effect on the score.  

TIP: In Excel reports, expand/collapse metric category rows via  
icon left of column “A”. Also, a blue underlined metric name in 
Column A is a hyperlink to its list.  

Run & customize lists from the Metrics Manager  
1. Right-click on the header row at the top of any list or in an 

expanded list. Or to work with Matching Objects first select 
the metric in the top window and then in Viewing above 
the bottom list select Matching Objects.  

2. From the right-click menu, check/uncheck fields to include 
in the list. The list varies based on the selected metric.  

3. Order/sort fields by drag and drop of column header labels.  
4. Filter a list by entering text the filter field above the list 

being filtered, clear the list to refresh the window.  
5. Right click header row for export choices of the full list or 

the list as displayed/sorted via Export Displayed Rows… 
TIP: Expand a list via the expand icon  for a larger view with 
the same options to customize the fields, order, and export 
options by right click on the header labels.  
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BASICS TO USING SCHEDULE  IN NETPOINT 

 

 

 

 

Schedule MD (MD) runs up to 42 MD metrics and tallies100s of data metrics for a NetPoint plan.  
See the 4 basics steps to run MD below:  

1. Open MD in NetPoint & Enter Schedule Inputs  
1. Open a NetPoint plan & Schedule MD. With a NetPoint plan open, go to Metrics > Open Metrics Manager. The first 

time MD opens for a plan, MD Inputs will open.  

2. Enter Schedule MD Inputs. At a minimum, the Properties & Review & Sign tabs must be completed to set the metrics 
applied and thresholds. Further, the Signoffs and Narrative are the primary sources of every Comprehensive score.  

3. Save Inputs. Click Save to save MD Inputs. See MD Inputs any time via Metrics Manager (MM) List icon.  

 
NOTE: Any plan change, whether a calculated change in the plan or only 
a graphic edit (e.g., object color, grid size, or text edit) will archive the plan 
signoffs and new Revision, Stakeholders, and Signoffs are required to 
restore Comprehensive score.  
 

 

2. Exclude Unmeasured Metrics 
The first time the MM opens for a project, the score is artificially low since all metrics are scored even if they cannot be 
calculated. Hence, unless they are to be added (e.g., a WBS), all uncalculated metrics should excluded as follows:  

1. Identify Unmeasured Metrics. Look for asterisks which indicate the presence of an unmeasured metric in a tab. Go to 
each tab and expand nodes using  to see at excludable metrics displaying with NA with and an active check.  

2. Exclude metrics: In each tab, expand nodes to uncheck active checks and the red X changes to a gray NA icon. NA and 
header node check remain even if all component metrics are unchecked/excluded. Faded checks cannot be excluded.  

TIP: A metric is only eligible for exclusion if it does not apply (weather, risk, based on Schedule Properties Inputs, etc.) or if it 
cannot be calculated due to a lack of a denominator based on the metric definition. See definitions by hovering cursor over a 
metric label in the MM, click the View icon , or see complete list in the MD Cheat Sheets. 

 

 

 
 
 

 

Complete the Properties Tab 
1. Select Revision, Level, and Delivery from menus. 

2. Set criticality thresholds as critical and near-critical 
counts factor into several metrics.  

3. Completion Likelihood is not required (if not risked, 
risk metrics may be excluded).  

4. Next click the Review & Sign tab to complete the tab. 
Or, click Save to close the Inputs window and MD 
prompts saving the xer with inputs.  

Complete Review & Sign tab. Narrative Checklist 
1. Check the Narrative checkbox. 

2. In the bottom window Primary Checks tab, check Yes 
or No for each question.  

3. Complete all tabs until all questions show as 
Answered at the bottom of the checklist window.  
 

 
 

Finish Review & Sign. Add Revision, Stakeholders, & Sign-offs  
1. Click Add Revision. Type a name a click Enter. 

2. Click Add Stakeholder. Enter a name and click Enter.  

3. Click Undefined below Role and select role from the menu.  

4. Click the Signoff check box. The comment window opens for an 
optional comment. Click Continue.  

5. Click Sign in Confirm Signature (cannot edit signed stakeholder).  

6. Repeat steps 2-5 for new stakeholders and signoffs. To review the 
number of signoffs needed, in MM go to Comprehensive tab > 
Aligned > Signoffs to see the threshold (generally 4-5).  

7. When complete, click Save to save MD Inputs and MM opens.  

 

 



 

This guidance covers only the minimum steps necessary to run an MD analysis. For example, there are additional steps in MD Inputs available to include a base case, 
weather metrics using planned NOAA weather data, and completion likelihood, etc., but they are optional and can be easily added to an analysis. For more details on 
all steps and advanced options, please see the complete NetPoint User Guide only available via the NetPoint Help Menu.  

 

3. View & Report MD Results  
In each tab, metrics are divided into MD, DCMA, and Data Metric sections in the MM top window. Expand nodes, scroll the 
through list, click to select a metric and see the results in the lower results window as a visual widget, or go to the customizable 
matching object list, or run preformatted MD reports. Also, use filters in each tab to search it’s component metrics. 

1. Dashboard widget. Default MM display to visualize selected metric result.  

2. Matching object list. Expand node in the MM top window, and click row to select a metric, then select Matching 
objects in the Viewing menu to see a customizable results list in bottom window. 

3. Filters: Use the filter box above the window to filter the list below. Clear filter to refresh to complete MM results.  

4. Run MD reports. Run MD reports of the starting point before improving the plan.  

4. Use MD Results Lists to Directly Improve Plan & Scores.  
Using the MD reports, take action to improve the MD results by going to the lowest scoring MM tab and metrics to improve 
the score. Review the metric definiton and then interactively select and act on objects to see instant effect on the MD score.  

1. Save plan with a new name. This preserves the original plan before improvement.  

2. Manually log changes. MD does not log changes, so manually log if needed.  

3. Identify metrics to improve. Review reports and use MD icons to identify low scores. Then starting with the lowest 
scores by expanding nodes in top window and click on a metric row to select metric. Be sure uncalculated metrics are 
excluded as suitable.  

4. Review MD definition. Click MM View icon or refer to IQ Report or Summary Report for the metric definition and to 
understand how to remedy the metric score. 

5. Identify objects. In the MM, go to the Viewing > Matching Objects, then click on an object in the list to see the plan 
scroll to that object.  

6. Take action on the plan. With the object(s) selected in Viewing list, click Select to modify the object and/or or double click 
the object in the plan to edit the object itself, with other commands also available via the Highlight, Delete, etc., buttons.  

7. Improve MD score & run new reports. See instant refresh of MD results and run new reports via the MM List icon . 

TIP: More on results. Take time to explore the 100s of data metrics listed in each tab as they provide a great deal of project information. For 
example, use filter to find the % and lists of Links with Lags, the % of Critical and Near-critical activities, or Negative-total float 
activities, etc., to give very useful fact-based, neutral data of the schedule.  

MD reports offered via the MM List Icon  
1. Summary Report. Includes all metrics, scores, and definitions, 

but not matching object lists. Ideal for executive reports.  

2. IQ Report. Includes MD metrics, scores, definitions, and 
matching object lists. Ideal to drill down into results.  

3. DCMA Report. Includes only DCMA 14-point metrics, definitions, 
and matching object lists (only report of lags & leads).  

4. Deficiency Report. Includes all activities in a tornado diagram 
based on number of metrics breaking the threshold with the 
corresponding matching object lists. Does not include MD scores 
or definitions. Ideal to review activity impact on score.  

NOTE: Plan changes instantly refresh results and require new reports.  

TIP: In Excel reports, expand/collapse metric category rows via  icon 
left of column “A”. Also, a blue underlined metric name in Column A is 
a hyperlink to its list.  

Run & customize lists from the Metrics Manager  
1. Right click on the header row at the top of any list or in an 

expanded list. Or, to work with Matching Objects, first 
select the metric in the top window and then in Viewing 
above the bottom list select Matching Objects.  

2. From the right-click menu, check/uncheck fields to include 
in the list. The list varies based on the selected metric.  

3. Order the fields by drag and drop of column headers. 

4. Sort by fields by clicking on the header row label 

5. Filter a list by entering text the filter field above the list 
being filtered, clear the list to refresh the MM window.  

6. Right click header row for export choices of the full list or 
only as displayed/sorted using Export Displayed Rows… 

TIP: Expand a list via the Expand icon  for a larger view with 
the same options to customize the fields, order, and export 
options by right click on the header labels.  
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HOW is the Schedule IQ™ Score (v1.2) Calculated? 

Comprehensive Credible Well-Built Controlled 
A

lig
ne

d 

Narrative Score: The number of points given to the narrative 
checklist. 

Pr
ed

ic
ti

ve
 

Critical Activities: The number of incomplete activities 
whose criticality factor is ≤ the threshold, divided by the total 
number of incomplete activities. 

Lo
gi

ca
l 

Logic Index: The number of valid activity-to-activity links 
divided by the total number of activities. 

Fo
re

ns
ic

 

Hidden Forensic Delay: Left of the data date, 
the sum of all gaps on the path with the lowest 
forensic total float. 

Schedule Sign-offs: The number of stakeholders who have 
signed off on the schedule.  
 

Schedule Margin: The project completion date minus the 
latest early finish date of all activities or milestones divided by 
the project completion date minus the data date.  

Open Ends: Activities that have either no predecessors or no 
successors divided by the total number of activities. 

Breached Gaps: Links that span a period of time 
less than 0 and which have been actualized, 
divided by all actualized links.  

Fo
rm

ul
ai

c 

Subjective Durations: Activities designated as physical work 
whose durations are missing a formula and whose criticality 
factor is ≤ the near-criticality threshold, divided by all 
activities designated as physical work whose criticality factor 
is ≤ the near-criticality threshold. 

Inadequate Float: Activities with merge risk indices ≥ 0.5 
divided by the total number of activities. Merge risk indices 
are calculated as an activity's merge float divided by its total 
float. 

Dangling Ends: Activities that have only finish-to-finish 
and/or start-to-finish predecessors or only start-to-start 
and/or start-to-finish successors, divided by the total number 
of activities. 

St
at

us
ed

 

Impractical Starts: The number of non-critical 
activities that start on early dates within 8 periods 
(for level 3 or 4 schedules) after the data date, 
divided by the total number of activities within 8 
periods after the data date. For level 1 or 2 
schedules, within 26 periods after the data date. 

Improper Detail: Incomplete activities designated as physical 
work with durations outside the recommended range, divided 
by all incomplete activities designated as physical work. The 
recommended range by level for each activity according to its 
calendar is: 2-12 months for level 1, 6 weeks-6 months for level 
2, 2-6 weeks for level 3, and ≤ 2 weeks for level 4. 

Hidden Delay: Right of the data date, the gap sum of the 
longest path (i.e., path with the lowest total float) divided by 
the duration of the longest path. 

Paired Activities: Activities connected by both start-to-start 
and finish-to-finish links to the same predecessor or successor 
divided by the total number of activities connected by start-
to-start, finish-to-finish, or start-to-finish links. 

Out-of-sequence Work: Actualized critical and 
near-critical successor activities whose start 
dates breach the logic tie type, divided by the 
total number of actualized critical and near-
critical activities. 

Co
m

pl
et

e 

Missing WBS: The number of activities without a WBS 
element divided by the total number of activities. 

Fl
ex

ib
le

 Schedule Gap Index: Right of the data date, the sum of all 
link gaps divided by the sum of remaining non-critical activity 
durations. 
 

Inhibiting Logic: Finish-to-finish + start-to-finish links with 
activity successors and zero-gap divided by the total number 
of finish-to-finish, start-to-finish, and start-to-start links with 
activity successors (links with benchmarks excluded). 

Improper Status: The number of actualized 
activities right of the data date + the number of 
non-actualized activities left of the data date. 

Missing Codes: The number of activities without a code 
divided by the total number of activities. 

Ri
sk

ed
 Completion Likelihood: The probability of completion as 

determined by risk analysis. 

Ph
as

ed
 Benchmark Frequency: The number of benchmarks with at 

least one predecessor or successor divided by the total 
number of years in the schedule. Re

-
ba

se
lin

ed
 Completion Likelihood Index: The completion 

likelihood in the revised baseline divided by the 
completion likelihood in the unprogressed 
baseline. 

Re
so

ur
ce

d 

Upcoming Overages: The number of time units (e.g., days) 
that resource levels exceed limits within 13 periods (e.g., 
weeks) after the data date, divided by the total number of 
time units with resources assigned within 13 periods after the 
data date. 

Re
so

ur
ce

-
flo

w
in

g 

Abnormal Resource Logic: The number of non-finish-to-
start links that have been designated as “Resource-Flow” 
divided by the total number of links designated as “Resource-
Flow”. 

Ca
le

nd
ar

-F
it

 Secondary Calendar Use: The number of activities 
designated as physical work assigned to secondary calendars, 
divided by the total number of activities designated as 
physical work.  

Tr
en

de
d 

Earned Schedule Index: The project duration at 
which planned percent complete (i.e., resource 
consumption) should have occurred (in the 
selected base case file) divided by the elapsed 
duration from project start to data date. If > 1.0, 
progress is ahead of schedule. If < 1.0, progress 
is behind schedule. 

Missing Resources: The number of activities designated as 
physical work without a resource divided by the total 
number of activities designated as physical work. 

W
ea

th
er

ed
 Planned Weather Index: Right of the data date, the number 

of planned weather days divided by the number 
of reasonably anticipated weather days. 

H
ie

ra
rc

hi
ca

l 

Missing Hammocks: Activities that aren’t associated with any 
hammock divided by the total number of activities. 

W
ea

th
er

ed
 Actual Weather Index: Left of the data date, the 

number of actual weather days identified 
divided by the number of observed weather 
days according to the selected NOAA weather 
station(s). 

Co
nf

or
m

in
g 

Breaching Finish Dates: Finish milestones or benchmarks 
that fall after their respective contract dates. 

Co
nf

or
m

i   Milestone Density: The number of milestones and 
benchmarks without contract dates divided by the total 
number of activities. 

  

Breaching Start Dates: Start milestones or benchmarks that 
fall before their respective contract dates. 

  

Co
nn

ec
te

d 

Questionable Logic: Start-to-start and finish-to-finish links with 
zero lags divided by all start-to-start and finish-to-finish links. 

  

Off-base Delays: Delay activities that are NOT modeling 
weather, and that are present in the unprogressed baseline 
schedule. 

  Constraints: The number of activities with constraints 
divided by the total number of activities. 

  

    PDM Logic: The number of non-finish-to-start activity-to-
activity links divided by the total number of links. 

  

    Improper Leads: The number of negative lags on finish-to-
start links that are longer than the predecessor duration. 

  

    Redundant Logic: The number of redundant links divided by 
the total number of links. 

  

    Extreme Logic: The number of start-to-finish links divided by 
the total number of start-to-finish, finish-to-finish, and start-
to-start links. 

  



WHY Does the Schedule IQ™ Score (v1.2) Matter?  

Comprehensive Credible Well-Built Controlled 
A

lig
ne

d 

Narrative Score: A schedule should align with the 
contractor planning basis. A lack of a narrative, or a low 
score, may justify withholding acceptance. 

Pr
ed

ic
ti

ve
 

Critical Activities: About 15%-30% of activities should be 
critical. A schedule with too many critical activities is more 
susceptible to delay. 

Lo
gi

ca
l 

Logic Index: To avoid an overly simple or an overly 
complicated network, the number of activity-to-activity links 
should be reasonably relative to the number of activities. 
1.25-1.75  for levels 1/2 and 1.5-2.5 for levels 3/4 

Fo
re

ns
ic

 

Hidden Forensic Delay: Gap on the as-built critical 
path should be ≤2 days. A broken as-built critical path 
contains concealed delays that should be made visible. 

Schedule Sign-offs: A schedule should be signed off by 4-
5 key stakeholders responsible for delivering the project. 
Too few or no signatures may represent a lack of credibility. 

Schedule Margin: The critical path reserves 5%-10% 
contingency. Otherwise, it is unlikely to correlate to a 
reasonable probability of on-time completion. 

Open Ends: Activities without a predecessor/successor 
should be ≤1%. Unconnected activities make a schedule 
unreliable for what-if, risk, and delay/disruption analysis. 

Breached Gaps: Negative gaps between two actualized 
activities should be ≤2%. Any occurrence significantly 
impairs total float reliability for forensic analysis. 

Fo
rm

ul
ai

c 

Subjective Durations: Critical/near-critical physical work 
activity durations should factor in production rates. 
Subjective durations are unreliable for schedule analysis 
unless established by the responsible stakeholder. ≤20% 

Inadequate Float: Activities with a high number of merging 
links should have sufficient total float. Otherwise, the risk of 
starting later is high due to overruns on multiple merging 
paths. ≤25% 

Dangling Ends: Activities with only finish-to-finish 
predecessors or only start-to-start successors should be ≤2%. 
Any occurrences may corrupt total floats and devalue risk 
analysis. 

St
at

us
ed

 

Impractical Starts: A reasonable number of imminent 
activities depending on schedule level should not be on 
early dates. Otherwise, it is not realistically reflecting how 
the work will unfold. ≤80% (levels 1/2 ), ≤60% (levels 3/4) 

Improper Detail: The majority of physical work activity 
durations should be of appropriate granularity so as to not 
impair progress measurement. ≤20% 

Hidden Delay: There should be 0 days of embedded gap on 
the critical path; margin should be reserved at the end of 
the critical path. 

Paired Activities: Activities connected by both start-to-start 
and finish-to-finish links should be ≤5%. Multiple occurrence 
may impair logic clarity. 

Out-of-sequence Work: Out-of-sequence progress should 
be repaired. Flawed actualized logic may render the 
schedule unreliable for delay/disruption analysis. ≤2% 

Co
m

pl
et

e 

Missing WBS: Activities should be developed using the 
WBS. An incomplete schedule may de-value schedule 
analysis and further be susceptible to delay and 
manipulation. ≤5% Fl

ex
ib

le
 Schedule Gap Index: The ratio of activity-to-activity link 

gaps to activity durations should be compared as the data 
date progresses. An unknown or lopsided rate of gap 
depletion undermines the credibility of the schedule right of 
the data date. ≥0.50 

Inhibiting Logic: Zero-gap finish to finish logic should be 
≤5%. If the successor has no other driving predecessor, then 
the zero-gap FF link is forcing the successor’s early start to be 
later than necessary. 

Improper Status: There must be no activities left or 
right of the data date that are inaccurately statused. 
Flawed actual dates may render the schedule 
unreliable for delay/disruption analyses. 

Missing Codes: Codes should be provided to organize, filter, 
and roll up activities. A lack of organization overcomplicates 
finding activities and status reporting. ≤5% 

Ri
sk

ed
 Completion Likelihood: The schedule should support a 

reasonable probability of completion for the completion date. 
A likelihood below 75% is generally considered high risk. 

Ph
as

ed
 Benchmark Frequency: There should be 1-2 benchmarks per 

year for total float allocation. Otherwise, overconsumption of 
total float by trade contractors early on may prematurely 
render downstream work critical or near-critical. 

Re
-

ba
se

lin
ed

 Completion Likelihood Index: A revised risk 
assessment should closely support the initially 
targeted probability of completion. A lower index 
suggests significant erosion of total float off the critical 
path and/or unaddressed delay. ≥0.95 

Re
so

ur
ce

d 

Upcoming Overages: The over-demand of key trades 
should be minimized, since leveling may not be solvable 
without extending project completion and/or unplanned 
acceleration. ≤10% 

Re
so

ur
ce

-f
lo

w
in

g Abnormal Resource Logic: Resource-flow links are 
inherently finish-to-start according to the movement of 
crew. A resource-flow link that is otherwise should be 
confirmed for accuracy. ≤5% 

Ca
le

nd
ar

-
Fi

t 

Secondary Calendar Use: Multiple calendars should be 
minimized for physical work activities. Unnecessary calendar 
variations exacerbate total float breaks and may blur logic 
chain patterns and critical path continuity. ≤5% Tr

en
de

d Earned Schedule Index: Percent complete (i.e., 
resource consumption) should progress on schedule. 
More activities and work effort than planned that are 
remaining as of the data date may render the balance 
of the schedule unrealistic. ≥0.95 

Missing Resources: 95% of physical work activities should 
be loaded with man-hours, crafts or crews, or dollars. 

W
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 Planned Weather Index: Planned adverse weather should 

be at least 95% of the reasonably anticipated mean for each 
month. Otherwise, schedule margin may be insufficient 
and/or the project completion may be delayed. ≥0.95 
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Missing Hammocks: Level 3 activities should be traceable to 
their parent level 2 activities. Loss of vertical traceability 
undermines schedule reliability. ≤5% 

W
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 Actual Weather Index: Actual stoppages should be 

within 20% of the weather observed by NOAA. 
Otherwise, it may indicate the station used was not 
representative of the actual site or a decision to work 
through abnormal adverse weather. 0.8-1.20 
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Breaching Finish Dates: Every contractual finish milestone 
should fall on or before the respective contract date. A 
failure may anticipate a breach of contract or false critical 
paths and visible or latent negative total floats. Co

nf
or

m
in
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 Milestone Density: Discretionary milestones and benchmarks 
should be used in a reasonable proportion to the number of 
activities and schedule level. 5-15% (levels 1/2), 2-5% (levels 
3/4). 

  

Breaching Start Dates: Every contractual start milestone 
should fall on or after the respective contract date. A failure 
may anticipate a breach of contract or false critical paths 
and overstated total floats. 
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Questionable Logic: Zero-lag start-to-start and finish-to-
finish links should be ≤5%, since it undermines the use of 
start-to-start and finish-to-finish relationships.   

   

Off-base Delays: There should be no delays where the 
data date equals the project start date. Otherwise, total 
floats are subject to manipulation. 

  Constraints: Activities with constraints should be ≤5%. Too 
many constraints render the schedule unreliable for what-if 
and delay/disruption analysis. 

  

    PDM Logic: Non-finish-to-start logic should not be overused, 
since it makes the logic more difficult to be understood by 
non-schedulers. ≤20% 

  

    Improper Leads: A successor should never start before a 
predecessor. 

  

    Redundant Logic: Redundant links should be ≤5%. Too many 
redundant links make it difficult to follow relationships and 
maintain the schedule. 

  

    Extreme Logic: Unless otherwise confirmed as reasonable, 
there should be no start-to-finish logic since it is extreme, 
complex, and difficult to follow. 
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NPT 
Only

MD 
Input Metric Threshold Definition

High Duration ≤ 5%
Resources 0% (!)
Activities 
Resources 

✓ Activities without an ID
✓ Activities without a Description

Codes
Info Objects

✓ Physical Work Activities
✓ Submittal Activities
✓ Commissioning Activities
✓ Validation Activities
✓ Closeout Activities
✓ Procurement Activities
✓ Delivery Activities
✓ Design Activities
✓ Other Work Type Activities
✓ Activities with Normative Durations
✓ Formulaic Activities
✓ Finish Benchmarks on Contract Dates
✓ Finish Milestones on Contract Dates
✓ Start Benchmarks on Contract Dates
✓ Start Milestones on Contract Dates

High Float ≤ 5% (!)
Critical Path Test - (!)
Critical Path Length Index ≥ 0.95
Activities with Total Float ≤ 10th percentile
Activities with Total Float ≤ 5th percentile
Negative-total-float Activities
Zero-gap Links
Negative-gap Links
Positive-gap Links
Links with Gap ≥ 20 Periods
Mean Total Float
Median Total Float
100th Percentile Period Density
20th Percentile Period Density
50th Percentile Period Density
Average Period Density
Critical Activities

✓ Near-critical Activities
Critical Path Total Float
Extreme Gap Links
5th Total Float Percentile
10th Total Float Percentile
80th Total Float Percentile
Activities with Extreme Total Float
Activities with Buffer = 0

✓ Anticipated Weather (NOAA)
✓ Planned Weather
✓ Normal Weather Days Per Year
✓ Weather Calendars
✓ Activities on Weather Calendars

The number of days right of the data date due to weather as modeled in the Schedule MD Inputs.
The number of planned weather days right of the data date divided by the number of years from the data date to the project finish date.
Calendars that have been designated as including weather.
Activities assigned a calendar in their property boxes, which has been designated as including weather.

10% of incomplete activities have this amount of total float or less.
80% of incomplete activities have this amount of total float or less.
Activities whose total float is at or above the 80th total float percentile.
Activities which if delayed, delay at least one successor.
The number of weather days of project right of the DD based on a 10-year average observed by NOAA for the selected weather station(s).

Activities whose criticality factor is ≤ the threshold (user defined). For current thresholds, see the Schedule MD Inputs.
Activities whose criticality factor is > the criticality threshold, but ≤ the near-criticality threshold (user defined). See threshiolds in MD Inputs.
The total float of the last object on the longest path (excluding benchmarks).
Links whose gap is greater than or equal to the 80th percentile total float, multiplied by 80%.
5% of incomplete activities have this amount of total float or less.

The 50th total float percentile, after ordering all activities from least total float to largest total float.
The highest number of activities taking place during any period (e.g. any week for a schedule in days).
80% of the weeks (for a schedule in days) from project start to project finish have at least this many activities taking place.
50% of the weeks (for a schedule in days) from project start to project finish have at least this many activities taking place.
The number of activities divided by the number of periods (weeks for a schedule in days) from the project start date to the project finish date.

Links which do not span any period of time.
Links which span a period of time less than 0.
Links which span a period of time greater than 0.
Links which span a period of time more than 20 periods (e.g. weeks for a schedule in days).
The sum total float of all activities, divided by the number of activities in the schedule.

Whether or not the last activity on the critical path shifts in direct proportion (within 90%) to a delay to another activity on the critical path.
Critical Path Length + total float divided by the critical path length.
Incomplete activities whose total float is less than or equal to the 10th percentile. For more info, see metric "10th Total Float Percentile".
Incomplete activities whose total float is less than or equal to the 5th percentile. For more info, see metric "5th Total Float Percentile".
Activities that, due to a delay or advance, are affecting the project completion or start, or interm completion event (benchmark).

Finish benchmarks which are finishing on or before the input contract date.
Finish milestones which are finishing on or before the input contract date.
Start benchmarks which are starting on or after the input contract date.
Start milestones which are starting on or after the input contract date.

Incomplete activities with total float > 44 days divided by the total number of incomplete activities.

Activities that have been designated as "Delivery" in their property boxes.
Activities that have been designated as "Design" in their property boxes.
Activities that have been designated as "Other" in their property boxes.
Incomplete physical work activities with durations in recommended range (Recommended  range by level for each activity according to its calendar is: 2-12 months for level 1, 6 weeks-6 months for level 2, 2-6 weeks for level 3, and ≤ 2 weeks for level 4.
Activities that have had formulaic durations entered in their property boxes.

Incomplete activities with duration > 44 days divided by the total number of incomplete activities.
Incomplete activities without resources divided by the total number of incomplete activities.
Excludes resource dep tasks. The building blocks of a schedule. Activities span a duration from start date to a finish date, each date portrayed by an end node.
People, equipment, facilities, materials, funding, or anything else required to carry out the project's activities.
Activities without a user-input unique identifier.
Activities whose text field for naming or summarizing is empty.
Applied to activities, milestones, and benchmarks for categorizing, organizing, sorting, filtering, or reporting more easily.
External files or attachments embedded on the canvas or on activities within NetPoint.
Activities that have been designated as "Physical Work" in their property boxes.
Activities that have been designated as "Submittal" in their property boxes.
Activities that have been designated as "Commissioning" in their property boxes.
Activities that have been designated as "Validation" in their property boxes.
Activities that have been designated as "Closeout" in their property boxes.
Activities that have been designated as "Procurement" in their property boxes.
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NPT 
Only

MD 
Input Metric Threshold Definition

              Logic ≤ 5%
Leads 0% (!)
Lags ≤ 5% (!)
Relationships ≥ 90% (!)
Hard Constraints ≤ 5%
Milestones
Hammocks (LOEs)
Object-to-object Links
FS Links
Activity-to-activity Links
FS Links with Lag
FS Links with Lead
Activities with FS/SS & FF Predecessors
Activities with Open Starts
Activities with Open Finishes
Start Milestones with Open End
Finish Milestones with Open End
Calendars In-Use
Activities on Constraints
Activities on SNE Constraints
Activities on FNL Constraints
Activities with Dangling Start
Activities with Dangling Finish
FS Leads > Predecessor Duration
Zero-lag SS + Zero-lag FF Links
Milestone/Benchmark Density
Redundant Links
SS + FF Links
Paired SS/FF Links
Activities on Paired SS & FF Logic
Calendar Periods
Logic Loops
Holidays Per Year

Negative Float 0% (!)
Invalid Dates 0%

✓ Missed Tasks -
✓ Baseline Execution Index -

Activities Completed
Activities In-progress
Activities Remaining
Completed Milestones
Schedule Duration (Calendar Days)
Remaining Schedule Duration (CDays)
Activities on Early Dates
Activities on Late Dates

✓ ✓ Completed Near-critical Activities
Critical Path Length from Data Date
Critical Path Length from Project Start
Completed Negative-gap Links
Unprogressed Activities Left of DD
Progressed Activities Right of DD
Completed Critical Activities
Completed Links
Completed Zero-gap Links
Activities Starting on Data Date

✓ Completion Likelihood Index
✓ Observed Weather (NOAA)
✓ Actual Weather The number of weather days identified left of the data date according to all calendars.

Incomplete activities with no predecessor and/or no successor divided by the total number of incomplete activities.

Links between two completed or partially completed activities, so long as the embedded node (GPM) falls before the DD (for non FS links).
A completed link that does not span any time. A completed link is a link between two completed/ partially completed activities(GPM embed before DD for non-FS links).
Activities whose start dates coincide with the data date.
The completion likelihood in current schedule divided by the completion likelihood in base case schedule (regardless of revision or progress).
The number of weather days observed by NOAA left of the data date for the designated weather station(s).

The interval (including non-working) between the project start and the early finish date of the last  network object on path with lowest total float.
Completed links that span a period of time less than 0. A completed link is a link between two complete/partially complete activities (GPM embed before DD for non-FS links).
Activities left of the data date which have not been actualized yet.
Activities right of the data date which have already been actualized.
Completed activities whose criticality factor is ≥ the criticality threshold (user defined). For current thresholds, see the Schedule MD inputs.

Duration (in calendar days if the schedule is in days) from the data date to project completion.
Activities whose drift is less than or equal to 0.
Activities whose float is less than or equal to 0 and drift is greater than 0.
Completed activities whose criticality factor is > criticality threshold, but < near-criticality threshold. In Schedule MD Inputs.
The interval (including non-working) between the DD and the early finish date of the last network object on the path with lowest total float.

Activities which have had both their start and finish dates actualized. Outlined in blue, they can no longer be modified.
Activities which have begun but have not been finished. Intersecting with the data date, these activities are partially outlined in blue.
Activities which have not yet begun (which have not yet been actualized), and which take place right of the data date.
Milestones which have had their dates actualized. Outlined in blue, they can no longer be modified.
Duration (in calendar days if the schedule is in days) from the project start to project completion.

Number of holidays from project start to project finish date divided by number of years between project start to project finish date (assigned calendars).

Incomplete activities with negative float (GPM) or total float (CPM) divided by the total number of incomplete activities.
Completed activities before the data date + incomplete activities after the data date divided by the total number of activities.
Complete or incomplete activities with a baseline finish on or before DD whose current or actual finish is later than baseline finish, divided by # of activities with a baseline finish on or before the DD.
Completed activities divided by the number of activities that should have been completed according to the selected base case scenario.

The subset of all logic ties comprising start-to-start or finish-to-finish links.
Start-to-start and finish-to-finish links with the same predecessor and successor.
Activity and successor activity (or activity and predecessor activity) connected by both start-to-start & finish-to-finish logic ties.
Number of periods (e.g. week for a schedule in days) from the activity with the earliest early-start date to the activity with the latest early-finish date.
Circular relationship where an activity is both predecessor and successor to the same activity or chain. (DCMA Critical Path Test and Redundant link metrics cannot calculate until logic loops are removed).

Activities with at least one predecessor and at least one successor that have only start-to-start and/or start-to-finish successors.
A negative lag between a predecessor-successor finish-to-start link that exceeds the duration of the predecessor.
Start-to-start links with zero lag plus finish-to-finish links with zero lag (activity-to-activity only).
The number of milestones and benchmarks divided by the total number of activities in the schedule.
A link that cannot acquire zero gap under any combination of durations and lags, because successor is preceded by another successor to the activity or object.

The number of calendars with at least one or more activities, milestones, or benchmarks assigned.
Constraints are applied to dates to prevent activities from being moved earlier or later.
A start no-earlier-than constraint is applied to an activity early start date and prevents it from being moved earlier in time.
A finish-no-later-than constraint is applied to an activity late finish date and prevents it from being moved later in time.
Activities with at least one predecessor and at least one successor that have only finish-to-finish and/or start-to-finish predecessors.

Activities that have at least one finish-to-start OR start-to-start predecessor AND at least one other finish-to-finish predecessor.
Activities without any predecessors.
Activities without any successors.
Start milestones without any successors.
Finish milestones without any predecessors.

Relationships between any two objects (activities, milestones, or benchmarks).
Relationships where the successor cannot start before the predecessor has finished (finish to start).
Links between any two activities only.
FS logic tie datum that denotes the least time between the finish of the predecessor and the start of the successor.
Negative lag modeling an overlap between two finish-to-start-connected activities.

Incomplete links with lags divided by the total number of incomplete links.
Incomplete finish-to-start links divided by the total number of incomplete links.
Manually scheduled incomplete activities and/or incomplete activities with hard Must Start On, Must Finish On, Start No Later Than, or Finish No Later Than constraints divided by all incomplete activities.
Zero-duration events  represent key dates or points of progress in the schedule. Similar to activities, they track with the network if linked.
A type of activity used to represent or summarize a group of other activities, milestones, and/or benchmarks. NetPoint hammocks cannot be linked or assigned resources. 

Incomplete links with negative lags or negative gaps divided by the total number of incomplete links.
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SCHEDULE MD DETAILS 
The Schedule MD Inputs: The Narrative Checklists 
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The Narrative Checklists: Unprogressed Baseline)  

 

 

Narrative for unprogressed baseline is included with the schedule submittal  Yes  No 

Primary Checks 
Author is signator to the schedule  Yes  No 

Identifies key stakeholders who participated in the planning  Yes  No 

Identifies key subcontractors who participated in the planning  Yes  No 

Describes key assumptions used in the development of the schedule  Yes  No 

Describes the high level sequencing execution, including key deliveries  Yes  No 

Describes constructability reviews done and impact on the schedule  Yes  No 

Describes studies of availability of key resources to support the schedule  Yes  No 

Details basis for including owner, third-party, and delivery activities on the critical path  Yes  No 

Describes basis of critical path total float  Yes  No 

Lists prime and crucial milestones used for vertical traceability  Yes  No 
 

Secondary 

Assumptions 

Narrative is consistent with Core Traits of a Reliable Schedule  Yes  No 

Describes interactive planning sessions used to build the schedule  Yes  No 

Describes items not included and not supported in the schedule  Yes  No 

Identifies activities/logic depicting contractor interpretations  Yes  No 
 

Conformance 

Describes the “area” paths of execution within buildings  Yes  No 

Identifies crucial resource-flow logic ties & impact on critical path(s)  Yes  No 

Describes approach to incorporating contract dates in the baseline  Yes  No 

Describes inclusion of specified means and methods and scope not shown in the drawings  Yes  No 

Details basis for critical and near-critical activity formulaic durations  Yes  No 

Mentions that formulaic durations were based on a company historical database  Yes  No 

Mentions that activity owners were involved in estimating durations  Yes  No 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



The Narrative Checklists: Unprogressed Baseline)  

 

Completeness 

Identifies the average and peak resource demand vs. availability  Yes  No 

Describes how resources impacted estimating activity durations  Yes  No 

Identifies basis of WBS framework  Yes  No 

WBS chart is provided  Yes  No 

Identifies WBS element as a code category  Yes  No 

Describes activity ID codes as hierarchical allowing vertical traceability  Yes  No 

Mentions that activities are coded to their child or parent activity in the hierarchy  Yes  No 

Describes how work involving repeating activities is modeled  Yes  No 

Mentions how resource-flow logic ties are planner devised vs. software generated  Yes  No 

Crew-flow or similar charts for repeating activities are provided  Yes  No 
 

Critical Path 

Describes basis for minimal-value activities on the critical path  Yes  No 

Identifies links in critical and near-critical paths that are preferential  Yes  No 

Mentions that critical path total float was based on risk analysis  Yes  No 

Mentions that critical path total float is generated based on early completion vs. date constraints  Yes  No 
 

Risk 

Mentions that the project team created a risk register  Yes  No 

Risk register and probability impact matrix are included  Yes  No 

Describes risk mitigation scenarios evaluated and impact on schedule  Yes  No 
 

Forensics 

Baseline monthly and cumulative percent complete forecasts are depicted  Yes  No 

Documents basis for average and peak progress that can be attained  Yes  No 

Baselines the number of activities planned to be finished every month  Yes  No 
 

Progress 

Basis for determining normal adverse weather allowances is provided  Yes  No 

Conditions considered (i.e., wind, precipitation, etc.) are identified  Yes  No 

Mentions that weather is based on statistical analysis or contract specification  Yes  No 

Mentions that physical work and delivery activities are largely on the same calendar  Yes  No 

Bases for premium work and non-work days are identified  Yes  No 
 



The Narrative Checklists: Revised Baseline  

 

Narrative for progressed baseline is included with the schedule submittal  Yes  No 

Primary Checks 
Author is signator to the schedule  Yes  No 

Identifies key stakeholders who participated in the re-baselining  Yes  No 

Identifies key subcontractors who participated in the re-baselining  Yes  No 

Describes key assumptions used in re-baselining the schedule  Yes  No 

Describes revisions in the high level sequencing execution  Yes  No 

Describes constructability reviews done and impact on the schedule  Yes  No 

Variance analysis for critical and near-critical activities is provided  Yes  No 

Documents delay(s) causing negative total float  Yes  No 

Documents time extension request for owner caused delay, if any  Yes  No 

Documents recovery plan executed to eliminate contractor delay  Yes  No 

Provides a comparison between actual weather and normal weather  Yes  No 

 

Secondary 

Assumptions 

Narrative is consistent with Core Traits of a Reliable Schedule  Yes  No 

Describes interactive planning sessions used to revise the schedule  Yes  No 

Describes assumptions re: rate of progress over the next 3 months  Yes  No 

Describes basis for revising durations based on actual production rates  Yes  No 
 

Conformance 

Describes revisions in the “area” paths of execution within buildings  Yes  No 

Identifies revised resource-flow logic ties & impact on critical path(s)  Yes  No 

Describes revisions in approach to incorporating contract dates  Yes  No 

Describes revisions in specified means and methods and scope shown not in the drawings  Yes  No 

Describes studies of availability of key resources to support the re-baseline  Yes  No 

Reconciles the average and peak resource demand vs. availability  Yes  No 

Describes how resources impacted schedule recovery and durations  Yes  No 
 

 

 

 

 



The Narrative Checklists: Revised Baseline  

Critical Path 

Variance analysis for critical and near-critical milestones is provided  Yes  No 

Mentions that negative variances on critical and near-critical paths are reducing  Yes  No 

Details basis for revisions in owner, third-party, and delivery activities  Yes  No 

Provides basis for added minimal-value activities on the critical path  Yes  No 

Identifies links in critical and near-critical paths that are preferential  Yes  No 

Provides reconciliation of remaining critical path total float  Yes  No 

Identifies critical path length index as similar to the prior 3-update average  Yes  No 

Identifies % of activities on the critical path as similar to the prior 3-update average  Yes  No 
 

Risk 

Mentions that the project team created a risk register  Yes  No 

Risk register and probability impact matrix are included  Yes  No 

Describes risk mitigation scenarios evaluated and impact on schedule  Yes  No 
 

Forensics 

As-built percent complete curve is provided  Yes  No 

Baseline forecast vs. actual percent complete is reconciled as to causes  Yes  No 

Identifies baseline execution index ≥ 0.95  Yes  No 
 

Progress 

Provides documentation supporting days lost due to adverse weather  Yes  No 

Criteria for normal and actual adverse weather are the same  Yes  No 

Describes actual dates and remaining duration protocols     

Mentions that in-progress activities were statused by estimating remaining duration     

Mentions that actual dates for critical/near-critical activities are exact to the day +/- 1  Yes  No 
 

Non-Progress 

Summarizes the parts of the schedule targeted for NP revisions  Yes  No 

Identifies NP revisions affecting critical and near-critical activities  Yes  No 

Identifies other NP revisions in logic ties, milestones, & benchmarks  Yes  No 
 

Data Date 

Describes how planned dates within 8 weeks right of DD were developed  Yes  No 

Mentions that resource leveling was used to establish planned dates right of DD  Yes  No 

Mentions that key stakeholders were involved in developing planned dates right of DD  Yes  No 
 

 



The Narrative Checklists: Update  

 

 

Narrative for the update is included with the schedule submittal  Yes  No 

Primary Checks 
Provides responses to owner’s comments on prior update  Yes  No 

Variance analysis for critical and near-critical activities is provided  Yes  No 

Identifies how negative variances on critical and near-critical paths are reducing  Yes  No 

Provides reconciliation of remaining critical path total float  Yes  No 

Identifies critical path length index as similar to the prior 3-update average  Yes  No 

Documents delay(s) causing negative total float  Yes  No 

Provides documentation supporting days lost due to adverse weather  Yes  No 

Describes how planned dates within 8 weeks right of DD were developed  Yes  No 

Mentions that in-progress activities were statused by estimating remaining duration  Yes  No 

Mentions that actual dates for critical/near-critical activities are exact to the day +/- 1  Yes  No 
 

Secondary 

Assumptions 

Narrative is consistent with Core Traits of a Reliable Schedule  Yes  No 

Describes basis for revising durations based on actual production rates  Yes  No 

Describes assumptions re: rate of progress over the next 3 months  Yes  No 

Identifies information not available in time to include in the update  Yes  No 
 

Critical Path 

Potential recovery plan in response to negative variances is outlined  Yes  No 

Identifies % of activities on the critical path as similar to the prior 3-update average  Yes  No 

Potential recovery plan to mitigate contractor delay is outlined  Yes  No 

Mentions that negative total floats are reducing  Yes  No 
 

Forensics 

As-built percent complete curve is provided  Yes  No 

Baseline forecast vs. actual percent complete is reconciled as to causes  Yes  No 

Identifies baseline execution index ≥ 0.95  Yes  No 
 

Progress 

Provides a comparison between actual weather and normal weather  Yes  No 

Criteria for normal and actual adverse weather are the same  Yes  No 

Describes actual dates and remaining duration protocols  Yes  No 
  

http://pmaconsultants.com/publications/core-traits-of-reliable-schedule/


The Narrative Checklists: Update  

 

 

Non-progress  

Minor delay that was mitigated and corrective action are described  Yes  No 

Minor, non-progress revisions are identified  Yes  No 

None of the non-progress revisions impact critical or near-critical paths  Yes  No 
 

Data Date 

Mentions that resource leveling was used to establish planned dates right of DD  Yes  No 

Mentions that key stakeholders were involved in developing planned dates right of DD  Yes  No 
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What Metrics (v1.2)  Apply to .xer Files? (33) 

Comprehensive Credible Well-Built Controlled 

Narrative Score Critical Activities Logic Index: Hidden Forensic Delay 

Schedule Sign-offs Schedule Margin Open Ends Breached Gaps 

Subjective Durations Inadequate Float Dangling Ends Impractical Starts 

Improper Detail Hidden Delay Paired Activities Out-of-sequence Work 

Missing WBS Schedule Gap Index Inhibiting Logic Improper Status 

Missing Codes Completion Likelihood Questionable Logic Completion Likelihood Index 

Upcoming Overages Abnormal Resource Logic Secondary Calendar Use Earned Schedule Index 

Missing Resources Planned Weather Index Missing Hammocks Actual Weather Index 

Breaching Finish Dates  Milestone Density  

Breaching Start Dates  Benchmark Frequency  

Off-base Delays  Constraints  

  PDM Logic  

  Improper Leads  

  Redundant Logic  

  Extreme Logic  

What Metrics (v1.2)  Apply to Unprogressed Baselines? (35) 

Comprehensive Credible Well-Built Controlled 

Narrative Score Critical Activities Logic Index: Hidden Forensic Delay 

Schedule Sign-offs Schedule Margin Open Ends Breached Gaps 

Subjective Durations Inadequate Float Dangling Ends Impractical Starts 

Improper Detail Hidden Delay Paired Activities Out-of-sequence Work 

Missing WBS Schedule Gap Index Inhibiting Logic Improper Status 

Missing Codes Completion Likelihood Questionable Logic Completion Likelihood Index 

Upcoming Overages Abnormal Resource Logic Secondary Calendar Use Earned Schedule Index 

Missing Resources Planned Weather Index Missing Hammocks Actual Weather Index 

Breaching Finish Dates  Milestone Density  

Breaching Start Dates  Benchmark Frequency  

Off-base Delays  Constraints  

  PDM Logic  

  Improper Leads  

  Redundant Logic  

  Extreme Logic  

What Metrics (v1.2)  are Adjusted for Level? (6) 

Metric Level 1/2 Level 3/4 

Logic Index 1.25-1.75 1.5-2.5 

Impractical Starts Within 26 periods, ≤80% Within 8 periods, ≤60% 

Subjective Durations ≤20% outside 2-12 months (L1), 6 
weeks-6 months (L2) 

≤20% outside 2-6 weeks (L3), ≤ 2 
weeks (L4) 

Missing Hammocks - ≤5% 

Schedule Sign-offs ≥5 ≥4 

Milestone Density 5%-15% 2%-5% 

What Metrics (v1.2)  Apply to Revised Baselines? (41) 

Comprehensive Credible Well-Built Controlled 

Narrative Score Critical Activities Logic Index: Hidden Forensic Delay 

Schedule Sign-offs Schedule Margin Open Ends Breached Gaps 

Subjective Durations Inadequate Float Dangling Ends Impractical Starts 

Improper Detail Hidden Delay Paired Activities Out-of-sequence Work 

Missing WBS Schedule Gap Index Inhibiting Logic Improper Status 

Missing Codes Completion Likelihood Questionable Logic Completion Likelihood Index 

Upcoming Overages Abnormal Resource Logic Secondary Calendar Use Earned Schedule Index 

Missing Resources Planned Weather Index Missing Hammocks Actual Weather Index 

Breaching Finish Dates  Milestone Density  

Breaching Start Dates  Benchmark Frequency  

Off-base Delays  Constraints  

  PDM Logic  

  Improper Leads  

  Redundant Logic  

  Extreme Logic  

What Metrics (v1.2)  Apply to Updates? (39) 

Comprehensive Credible Well-Built Controlled 

Narrative Score Critical Activities Logic Index: Hidden Forensic Delay 

Schedule Sign-offs Schedule Margin Open Ends Breached Gaps 

Subjective Durations Inadequate Float Dangling Ends Impractical Starts 

Improper Detail Hidden Delay Paired Activities Out-of-sequence Work 

Missing WBS Schedule Gap Index Inhibiting Logic Improper Status 

Missing Codes Completion Likelihood Questionable Logic Completion Likelihood Index 

Upcoming Overages Abnormal Resource Logic Secondary Calendar Use Earned Schedule Index 

Missing Resources Planned Weather Index Missing Hammocks Actual Weather Index 

Breaching Finish Dates  Milestone Density  

Breaching Start Dates  Benchmark Frequency  

Off-base Delays  Constraints  

  PDM Logic  

  Improper Leads  

  Redundant Logic  

  Extreme Logic  
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